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�Overview

Introduction



The Shrimp Farm System has been designed to let you store, interrogate and make the most of the information you collect on your farm, in the easiest possible way.  This manual will take you through the system, step by step, and show you how to manage your shrimp farming business - from production to financial control.



The system is structured like this:







�





This means that each pond, whether being used as a reservoir or for shrimp production, is assigned to a certain unit, which in turn is running a certain crop, for a certain farm, under the control of a Head Office.



Each crop is a cycle consisting of four steps:



a preparation period

the stocking of the pond

the production of the shrimp

the harvesting of the shrimp.



As each of these steps will vary from farm to farm, and indeed pond to pond, there are no restrictions as to their length.  This means that the system will be equally useful for farms which harvest once a cycle or twice a cycle, or have ponds which are only introduced in the middle of a cycle, i.e. staggered stocking.



The system has been designed to be as flexible as possible, so that no matter what size your farm is and how you choose to run it to, the Shrimp Farm System will allow you to store information efficiently and generate reports and graphs, at any stage in your farm cycle, thus maximizing efficiency.



Features



The AquaSoft system incorporates the following powerful features:



Feed and water management - accurate recording from farm input data using a Windows based interface.



Inventory control - maintains detailed inventory records and produces reports that help you manage your stocks efficiently.



Report and graphing facility - comprehensive reports and scientific graphs for analysis of production data and management decision making.



Financial analysis - together with inventory control, financial reporting shows detailed sales and profit analyses.



System Recommendations



The AquaSoft system is powerful and complex.  It will operate on most computers, but on older models it may be slower.  Below are the programmer’s recommendations for running this system.  These will ensure that it will operate at the high speed it has been designed to achieve.



A 486 or better PC



A computer with a speed of 50 megahertz or better



8 megabytes RAM



25 megabytes free hard disk space



Microsoft Windows 3.1 or better





Installation



The installation of the system has been made as simple as possible.  You will have received 3 sets of installation disks, which make up the three parts of your system:



The AquaSoft Farm Management System

The Report viewer

The Underlying Database Engine controlling all your farm information.



To install the system, you first must install the Database Engine:



Insert “BDE disk 1” into your disk drive.

In Windows “Program Manager”, go to the “File” menu and choose “run”.

In the dialog box that appears type “a:\setup”.  (If your floppy disk drive is not “a:”, simply replace “a:” with your drive’s label. e.g. b:\setup.)

Follow the on-screen instructions, changing disks when prompted.



Once the Databse Engine is installed, install the Report Viewer:



Insert “REPORTSMITH disk 1” into your disk drive.

In Windows “Program Manager”, go to the “File” menu and choose “run”.

In the dialog box that appears type “a:\install”.  (If your floppy disk drive is not “a:”, simply replace “a:” with your drive’s label. e.g. b:\install.)

You will be asked to confirm the location of the Database Engine.  Make sure that the directory given is that which you used.

Follow the on-screen instructions, changing disks when prompted.



Note:  On the screen “Connect Options”, all options can be de-selected.  They are not necessary and so only occupy valuable disc space.



Once the Database Engine and Report Viewer are installed, install the AquaSoft System itself:



Insert “AQUASOFT disk 1” into your disk drive.

In Windows “Program Manager”, go to the “File” menu and choose “run”.

In the dialog box that appears type “a:\install”.  (If your floppy disk drive is not “a:”, simply replace “a:” with your drive’s label. e.g. b:\install.)

Follow the on-screen instructions, changing disks when prompted.



Note:  The AquaSoft system should be installed in “c:\Aquasoft” (where c: is your Hard Disc.) to ensure smooth running of the system.



After installation, the system is loaded by double clicking on the AquaSoft icon in the AquaSoft group.  You will then be asked for the password supplied with your system.  After you have typed in your User name and Password, your system will be operational.  But before you can run it, your computer needs an initial Authorization code. Until this is done, you will receive a message saying:



“The program has no authorisation.  Read the installation section of your manual to find out how to get authorisation from SNR”



To get your Authorization:



Start the AquaSoft system and type in your password.

On the screen which appears, choose the “File” menu. 

Click on “Security”.

The screen that appears will give you your Site code, as well as space to type your authorization code.  The Site code identifies your system to the computer in SNR, which will produce a code, the authorization code, allowing your system to be used with your specifications.

Note down your Site code and complete the AquaSoft registration form provided and return by fax to SNR



Fax:	(662) 308 2997



SNR will fax in return your  authorization code, which is unique to your system.  Type this code into the “Authorization Code” box, then click on “authorize”.



Transferring the system to another computer



The AquaSoft system has been designed to run on only one computer at a time.  However, at some point in the operation of your system, it may be necessary to change the computer it is operating on, for example if you upgrade to a new computer.  The system has been designed to make this as simple as possible, while ensuring the protection of copyright.  To transfer the system to another computer:



In the new computer, install the system using the original installation disks.

Choose “Security” from the “File” menu on the main screen of your newly installed system.

Now click on the “Transfer” tab at the bottom of the screen.  Here you must specify a drive or directory to which both computers have access.

Unless you are operating on a network, this common drive or directory should be “a:” (or the letter specifying your floppy disk drive).

If you have specified “a:” as the drive or directory, insert a blank disk in the disk drive.  Now click on the “Transfer register” button.  This will copy some information to the disk.

Back in the old copy of the system, go to the “Security” window and click on the “Transfer” tab.  Choose the drive or directory you specified as being common (for example “a:”.  Insert the disk just created from the new system into the old computer’s disk drive, then choose “a:”).  Click on the “Transfer out” button.  Your old system is now inoperable and the authorization can now be transferred to the new computer.

In the new computer, now click on the “Transfer in” button (if your common area is the disk, place the disk in the disk drive).  The authorization for the system has now been transferred to your new computer and the system is now fully operational.



Although your system has been transferred to your new computer, the information stored in the system has not.  All information is stored in a file named “phoenix.gdb” in the “Database” sub-directory of the directory you installed your system to (usually “AquaSoft”).  If the two computers concerned are not physically connected, this must be done using floppy disks.  Unfortunately, the file can grow very large after a time, and it is likely that it will be too large to fit on a single floppy disk.





To transfer this information, you must use a program such as “Microsoft Backup” which comes with Windows.  Refer to your Windows manuals to learn how to backup this file to floppy disks, then restore it using the same program on your new system.



On-line help



The system has been equipped with comprehensive on-line help.  At the bottom of almost every screen, you will see a � button.  Clicking on this will bring you to help relating to the screen you are working on.



So as to make the help as easy to use as possible, the relevant screens have been included.  You can click on the parts of the screen shown where a � appears for explanations of features.



For more information on using help files, please refer to your Windows Manual.



If you have a problem which you cannot solve using the manual and on-line help, feel free to seek advice using the following numbers:





Telephone: (662) 308 2016/8

Fax:	(662) 308 2997

E-Mail:	snr@ksc.net-th



Note: Many problems can be fixed by simply restarting your system.  If you encounter a problem, try exiting restarting AquaSoft and Windows.  If the problem persists, please seek advice using the above numbers.





The system



The Shrimp Farm System has been designed to be as easy to use as possible.  Everything is accessible from the main screen, using on-screen buttons and menus.  This manual takes you through the whole system, with step by step instructions and examples.



The main screen
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This screen is the gateway to all parts of your shrimp farm system.  Options can be chosen either from the menu bar or from the “Tasks” bar (see above), with each approach giving exactly the same results.









The “Tasks” bar gives you three choices - Setup, Production and Inventory.  Each of these, when selected, has its own set of buttons underneath. On the screen above, there is a black dot like this  (  beside “Setup”, and the buttons underneath will allow you to enter the setup side of your system.  By clicking on “Production”, the  (  will move and the buttons will change to allow you to access the production side of the system.  The same will happen with “Inventory”. You will now work through each of these three choices in turn.



Setup



Before you start using your system for a working farm, you must first enter information such as addresses, farm sizes and farm configuration.  This information can be changed or updated at any point of your cycle, allowing for any possibility.



Address Book



You must start by entering appropriate addresses.  After choosing “Setup” from the main screen, click on the “Address Book” button.



This new menu gives you two choices, as described below.  To choose one, simply click on its button.





�Note:  Any button marked with a     leads to another set of buttons.  This makes options easier to find and makes it less likely that you will get lost in a maze of options.



Head Office



Now choose “Head Office” by clicking on it.

The following screen appears:



�
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Simply type in the information relating to your organization by clicking in the appropriately labeled boxes.  When you are finished, click on the “Close” button.  Your information is now stored and you will be returned to the main screen.

If at a later date you need to edit this information, simply follow the same steps and make any changes necessary.



Using the same method, you can enter the names and addresses for the farms under this Head Office.









Farms



From the “Address Book” menu, you now click on “Farms” and the following screen appears:





�





Enter all the information for your farm, including the specific area and currency unit you wish to use.  These will be used in relation to this farm throughout the system.

Once you have entered the information for your first farm, click on the �  button, and the farm will appear in the bottom half of the screen.

To add another farm, you simply click on the �button and type in the new information in the new blank form.



To edit farm information, simply choose the farm you want to change from the list in the bottom half of the screen, then click on the �button.

To delete a farm, choose it from the list, then click on the �button.





Note:  If you are running only one farm, your Head Office may well be part of your Farm.  If this is the case, you must still enter the information for both sections, even though it is the same.



Suppliers



The method for adding, editing and deleting Suppliers from your system follows the same method as for adding farm information.  From the “Address Book” menu, you simply choose the “Suppliers” button and enter the information.  You will notice that the screen layout is the same as for “Farms” and all buttons perform the same tasks as before.



The only difference is that each farm has its own set of suppliers, so you must first specify the farm concerned.  This is done on the “Choose Farm” screen, as below:
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All the information you will add to complete your setup is farm specific, so you will see this screen over and over again.



Note:   If you have suppliers common to more than one farm or unit, there is no need to retype the information.  Simply click on “Tools” on the menu, then “Import Setup”, then choose the farm or unit you want to copy and click on “OK”.  The system will now copy this setup across for you.  



This feature applies anywhere in the system where the “Tools” option is shown at the top of the screen.



Production



Now that your farms have been added to your system, you can move to the production side of the setup.  All the following choices are found under the “Production” button, from the “Setup” menu on the main screen.  For each choice you must also choose a farm, using the “Choose Farm” screen as indicated before.

Ponds and Reservoirs



Here, you will add the ponds and reservoirs for each farm.



After choosing the appropriate farm, the following screen appears:
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On the left hand side, you have a list of what you can include on your farm.  This layout is used often from now on, so it is important to understand the method of adding choices from this list.



To add from this list, first you must highlight what you want to add.  In the case of ponds, there are two choices - a shrimp bearing pond or a reservoir.  To add a pond, simply click on “Pond” and, holding down the mouse, drag it into the table on the right.  When you let go of the mouse, an entry for a pond is now shown.



If you are uncomfortable with the “Click and Drag” method, you can use the button bar like you did earlier.  To add a pond in this way, simply click on “Pond” in the “Type” list, then click on the�) button.



Now, you must name the pond, give its area and specify whether it is currently in use.  This is done in the boxes above the list of entries.



The method for adding reservoirs is the same.  You choose “Reservoir” from the “Type” list, and use either of the above methods to add it to your list.



As described under “Suppliers”, if you have more than one farm with the same setup, you need only type it in once.  For example, the above screen shows the setup for the Farm “Demo Farm”.  If you want “Demonstration Farm 2” to have the same setup, you can open it, then choose “Import Setup” from the “Tools” menu at the top of the screen.  In the box which appears, choose “Demo Farm” and click on “OK”.  The system will copy the setup across for you.



When you have finished adding all your ponds, click on the “Close” button.



You should now repeat this process for each farm, until all your farms are correctly configured with the ponds available to them.  Notice that the number of ponds which your system has been authorized to run is shown here.  This gives you the chance to check your allocation numbers as you proceed.





Note:  When you are naming your farms, try to keep names the same length.  For example, if your farm has 80 ponds, name your first pond “pond-01” as opposed to “pond-1”.  This will ensure that your ponds are displayed in the correct order throughout the system.  If you do not do this, in a list of ponds, “Pond-10” will come before “Pond-2” since this is the alphabetical order.

Units



Here, you can split your farm up into units.  This makes management of a large farm easier.  If your farm operates as one unit, you must still set up the farm as a single unit, here.



Once you have chosen the appropriate farm, a screen appears that is very similar to that for adding ponds.  You should notice that there is no list down the left hand side of the screen, since there are no categories to choose from.

To add a unit, first click on the “Insert” button, and type in the name of your unit, and then click on the “Post” button.

To add another Unit, repeat the process.

When you are finished adding all your units, click on the “Save” button.



Unit storage

Here you will assign ponds to the units you have just named



Once you have chosen the appropriate farm, a screen appears that is very similar to that for adding ponds.  The list down the left hand side of the screen shows us all ponds available for the unit shown at the top of the screen.

First, choose the unit you wish to deal with from the drop down list. The list down the left hand side will automatically change.

To add ponds, simply click on a pond from the list on the left hand side, then either click on � or drag it into your list.  Notice this is the same method we used in the “Ponds and reservoirs” section.

After each pond has been added, press the � button.

When you are finished adding all ponds, you save and return to the main screen.



Chart of Accounts



If you are planning to use an accounting package alongside this system, it is necessary to set up your "Chart of Accounts".  Each entry consists of an Account code and a Cost Centre.  This allows you to group the products named in the Products part of Setup for accounting purposes.



Once you have chosen the appropriate farm, a screen appears that is very similar to that for adding ponds.

To add an account, first click on the “Insert” button, and type in the code you wish to use, the Cost Centre for the account, then click on the “Post” button.  The code can be anything you wish, but it is advisable to make these codes meaningful.  For example, you may want accounts for tracking food expenses.  For this you could have two accounts - on for fresh food and one for dry food.  The fresh food account could therefore be called “ExpFf” for Expense account relating to fresh Food and the dry food account, “ExpFd” for Expense account relating the dry Food.

To add another account, repeat the process.

When you are finished adding all your accounts, click on the “Save” button.

Note: If you do not wish to use this aspect of the system, you must still set up one dummy entry which should be used when specifying product information. 

Indirect costs



This is for farm indirect cost allocation. For ease of allocation, indirect costs are donated as ‘cost / culture area / day’. For those farms with external accounting packages reconciliation can be done on completion of the crop cycle.



The method for adding these indirect costs is the same as for adding ponds.



Choose the appropriate farm.

Specify the cost and the estimated cost in the cost unit  “Cost / culture area / day”.

Save this entry by clicking on the “Post” button.

To insert another entry, simply repeat the process.

Click on the “Save” button when finished.

If you have already set up one farm with the correct indirect costs, you can transfer this set up using the “Tools” menu and “Import Setup”, as you have seen before.



Note: The indirect costs you specify here will be automatically added to each crop when it is started.  These can be changed and added to for individual crops later in the system.

Water quality parameters



This is where you tell the system what properties you want to monitor, in the water in your ponds.



Once you have chosen the appropriate farm, the following screen appears:
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Notice that the list on the left hand side of the screen, gives all the possible properties you may want to monitor.

To add one of these, you can use either the “Click and Drag” method, by clicking on the word and dragging it onto the entry list, or use the “Insert” button as before.

Once you have added the property to be monitored, you must name it.  

As an example, the list gives “Secchi depth”, which is measured in centimeters.  To add this, you can click and drag it into your list, or use the “Insert” button.  You may then want to call it “Transparency”, and you can do so now.

If you have already set up one farm with the correct parameters, you can transfer this set up using the “Tools” menu and “Import Setup”, as you have seen before.



Important:  If you measure the same statistic more than once a day, you must add this to your entries.  For example, if you measure pH twice a day, in your entries you should add pH twice, giving the two entries different names, such as “pH a.m.” and “pH p.m.”.  This will allow the system to reflect the full extent of your monitoring.  This is also very important for achieving accurate reports and graphs from your information.

Product categories



This is where you name the categories into which you split the products you use on your farm.  The method used is the same as for adding ponds.



After you choose the farm concerned, you are presented with a screen like that for adding ponds, with the list on the left hand side holding the system’s base categories.  All products will fit into one of these base categories.  It is these you want to split up into more meaningfully for the particular farm.  For example, on this farm you may use both fresh and pellet feed.  If this is so, then under “Feed” (from the list), you can choose one entry and name it “Fresh Feed”, and another, naming it “Pellet Feed”.  This lets you split up products in a more meaningful way. *



The method for adding and editing entries is the same as before, using either click and drag or the “Insert” button.

If you have already set up one farm with the correct categories, you can transfer this set up using the “Tools” menu and “Import Setup”, as you have seen before.



*	Note:  If you just want to use one of the base categories from the list, for instance “Lime”, without splitting it up further, you still have to add and name it here, or the system will not know that you want to use it.



Products



This is where you name the brand names and prices of the products used on your farm.  You must have added your product categories, suppliers and chart of accounts to the system before this step can be carried out.





Once you have chosen the appropriate farm, a screen similar to that for adding farms will appear.



Here you enter the information for each product.  The method for adding and editing entries is the same as before, using either click and drag or the “Insert” button. Notice that the Product categories, the Supplier names and the list of Chart of Accounts are those which you specified earlier.  You do not enter information on product prices here, since these are liable to change.  Prices are entered when products are stocked.



Once you have entered the information for your first product, click on the “Post” button, and the product will appear in the bottom half of the screen.



To add another product, simply click on the � button and type in the new information in the new blank form.



To edit product information, simply click on the farm you want to change, from the list in the bottom half of the screen, then click on the � button.









Another common editing task is to discontinue the product.  Either you can simply choose the appropriate product and click on the � button, or you can mark it as discontinued.  This is done by clicking on the “Continued” box so that the “x” disappears.  This means that the product is still stored in your system, but you will not be able to use it.  This is the better method if it is likely that you will use the product again at a later date.



In the list at the bottom of the screen, you can either show or hide products that have been discontinued, by switching on or off the “Show discontinued”  option.  When the box beside “Show Discontinued” is marked with an “X”, this option is active.



To continue a product that has been discontinued, simply edit it’s entry by clicking on the “Continued” box so that the “x” appears once again.  This will allow the product to be stocked and used once again.



When you are finished, click on the “Close” button.



Note:  The reorder level you specify here will be used throughout the system to warn you when you need to reorder a product.  Once the amount in stock falls below its reorder level, all new entries dealing with this product will appear in red on the screen.

Options



Time Interval:  For your convenience, when it comes to entering or searching for information involving time, it can be chosen from a list.  This list will give times from 0:00 to 24:00, going up in the intervals that you specify here.  This will become clearer  when you use the list.





Production



Now that you have set your system to run appropriately for your farm, you can start entering the information being collected.  Under “Production”, every option will lead you to the same screen.  This allows you to insert or retrieve information for the appropriate time and place.  The screen is called the Command Centre and will be referred to throughout this section.





The Command Centre screen 
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From the Command Centre screen you must first choose the farm you want to deal with, by clicking on it in the “Farm” list.  If the information you want to input also relates to a specific unit and crop for that farm, you then must choose the unit and crop from their lists. This is done in the four boxes along the top of the screen.  These will have a white background if their information is relevant and a gray background if not.  For example, when you are dealing with crop information, pond choice is unnecessary, so the Pond box is grayed.





Note:	The (crop open) icon beside the name means that the crop is still running.

The (Crop closed) icon beside the name means that the crop has been closed.



If the information is also for a specific pond, you choose it here.



Note:	An (pond shrimp) icon beside a pond name means it is being used for shrimp.

	An (pond reservoir) icon beside a pond name means it is being used as a reservoir.



Next you must specify the mode you want to work in.  The three modes that you can work in are:



“Insert data”  - This lets you add, edit and delete specific information for any point in time.

“Update data” -  This lets you edit information for a specific day.

“View data” -  This gives all relevant information for a topic, in list form, regardless of date and time.



The most commonly used is the “Insert data” option because it is the most flexible.  The examples in this manual deal mainly with this mode.  Methods for using “Update data” mode are the same, except only edits can be carried out.  In “View data” mode you are only allowed to review data, which can be chosen using the same methods as for the other two methods.



Then, if it is relevant to the mode you are in, you specify a date and a time for your new record to be added, or an existing one to be updated.



The day’s date is automatically given.  If this is not the date you need, you can click on a date from the calendar which appears when you click on the � button.



The time, too, is automatically given.  If you want to specify a different time, you can choose from the list given.  Note that the time here goes up in intervals equivalent to those you specified in “Options” in the “Setup” section.



The screen also has a � button, which brings up a further screen, like this:





�





As you can see, this sums up the dates of your cycle for each pond.  In the example given, you can see that Pond-05 began its preparation on 01/07/1994 (given as the day the crop was assigned), started the production part of the cycle on 30/07/1994 (given as the day the pond was stocked) and was harvested on 15/12/1994.













Crop cycle



This set of screens lets you set up the crops for each farm in your system.

Crop management



Here you will specify the information for the crop cycles on your farm.



From the Command Centre, choose the appropriate farm.  Notice that the Farm box is the only one with a white background, so only it’s information is relevant.

After making sure you are in “Insert data” mode, choose the date and time for the start of the crop cycle.

Click on “Execute”.

You can now enter crop information.  You should leave the “End Date” blank, since it will only be added after the crop has ended.

Once a crop has been completed, open this screen in “Update Data” mode and type the relevant date into the “Crop end date” box and press “Post”.  When you now enter the Command Centre screen, the icon beside the crop name will have changed from (crop open) to (crop closed).



Note:  The date given here for the Start date is used as the start of this cycle throughout the system.  On many forms you will see a figure for “Day”.  This tells you the number of days between the “Start Date” and the date of the entry concerned.

Pond management



Here you will assign ponds, which you have already set up, to the crop you have just named.



From the Command Centre, choose the appropriate farm and crop.

After making sure you are in “Insert data” mode, choose the date and time for the start of the ponds’ assignment.

Click on “Execute”.

To add ponds, you use the same method that you used for adding ponds to farms in the “Setup” part of your system. You simply click on a pond from the list on the left hand side, then either click on � or drag it into your list.

Once you have done this, you specify whether the pond is for shrimp or for reservoir and click on �.

When you are finished adding all ponds, you save and return to the main screen.



Indirect costs



This is where you specify any costs other than those listed under products for your crop.  In the “Indirect costs” section of your setup, you specified a set of default indirect costs.  Now you can change these for this specific crop, and add any more necessary.



From the Command Centre, choose the appropriate farm and crop

After making sure you are in “Insert data” mode, choose the date and time for the assignment of the overhead.

Click on “Execute”.

To add indirect costs, Type the name of the and estimate cost.  All costs are measured in “Cost / Culture Area / Day”.

Once you have done this, you click on (Button Post).

To edit a cost you specified earlier, simply click on the piece of information to change, press the � button and type in the new information.

To remove one of the costs you specified earlier, click on the entry and press the � button.

When you are finished adding all indirect costs, you save and return to the main screen.



Note:  The indirect costs you specified in the “Indirect costs” section of setup are only defaults.  You can change or delete any of them for a particular crop.

Pond preparation



When your ponds are ready for the preparation phase of your crop cycle, you will need to store your initial readings for each pond.

Water monitoring



Here you enter the initial values for the properties you specified in “Water Quality Parameters” in the “Setup” section of the system.



From the Command Centre, choose the appropriate farm, crop, unit and pond.

After making sure you are in “Insert data” mode, choose the date and time of the monitoring.

Click on “Execute”, and the following screen will appear:
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On the list on the left hand side of the screen, click on the relevant pond.

You can now go down your list and fill in the figures that have been collected.

To add information for another pond, simply click on it in the list.



Note:  If , as in the screen above, you have specified two readings for a certain property, this process must be carried out twice, at two different times. Under the first time specified, enter what information you can and leave the rest blank.  Once you have more information, you carry out the process again, using the second time.  The information you entered earlier will not appear at this stage, but is still held in the system.   To view all the readings for one day, simply change the mode in the Command Centre to “Update data” and click on “Execute”.







Water input



Here you enter the initial amounts for water related products that are to be added to your ponds.



From the Command Centre, choose the appropriate farm, crop, unit and pond.

After making sure you are in “Insert data” mode, choose the date and time for the addition.

Click on “Execute”.

On the list on the left hand side of the screen, click on the relevant pond.

You can now go down your list and fill in the figures that have been collected for each product added.

To add information for another pond, simply click on it in the list.



Note: The “In Stock” column shows the number of each product held in the inventory and is updated after each entry, when you press “Post”.  The number in stock of  products shown in red has fallen below the reorder level specified earlier.

Pond stocking



Here you enter and store the information on the stocking of your shrimp bearing ponds.



From the Command Centre, choose the farm, unit, and crop for which you are stocking.

The date and time of stocking should also be chosen at the bottom of the screen.

When you click on “Execute”, the following screen appears:
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This screen lists all the ponds associated with this unit and adds the date you specified to each.

You now enter the quantity of fry added (which could be in boxes, or another measurement), the actual number of fry added and the age of the fry, at stocking.  The “Available” column shows the number of each product held in the inventory and is updated after each entry, when you press “Post”.  The number in stock of  products shown in red has fallen below the reorder level specified earlier.

After entering each piece of information, click on “Post”.

When you are finished, click on “Save”.



Note: The date you have specified here is taken to be the “Start Date” for the “Production” part of your crop cycle for this pond.

Pond sampling



This is one of the most important parts of the system.  It is where you enter the information you collect during sampling.  This information will be used by the system to calculate crop statistics and later make predictions.



The method for storing this information is exactly the same as for entering pond stocking information. 



From the Command Centre, choose the farm, unit, and crop for which you are sampling.

The date and time of sampling should also be chosen at the bottom of the screen.

The sampling screen lists all the ponds associated with this unit and adds the date you specified to each.

You now enter the  sampling weight, number of shrimps and price per kilogram for each pond which you have sampled.

After entering each piece of information, click on “Post”.

You may enter sampling information here for any number of ponds.  If there is a pond not sampled, simply do not enter any values for it.

When you are finished, click on “Save”.



Note:  At the top of the screen the Mean Body Weight (MBW) and pieces per kilogram are calculated automatically for ponds you have entered information for.  To view these figures for a pond, click on the specific pond name.





Pond production



This is where you enter the everyday information collected from the farm.  This will be the section of the system most commonly used, since the information is collected throughout Production.



Feed management



Here you enter readings for the feed added to ponds.



From the Command Centre, choose the appropriate farm, crop, unit and pond.

After making sure you are in “Insert data” mode, choose the date and time for the start of the crop cycle.

Click on “Execute” and the following screen will appear:
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You can now go down your list and enter the figures that have been collected, clicking on “Post” after adding each piece of information.  Click on “Save” when finished.



Note: Items which have fallen below the re-order level you specified in the “Products” section of “Setup” are shown on screen in red.  The system will automatically update the values in the “Available” column when you add data to your inventory.

Water monitoring





Here you enter the values for the properties you specified in “Water Quality Parameters” in the “Setup” section of the system.



From the Command Centre, choose the appropriate farm, crop, unit and pond.

After making sure you are in “Insert data” mode, choose the date and time of the monitoring.

Click on “Execute”, and the following screen will appear:
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On the list on the left hand side of the screen, click on the relevant pond.

You can now go down your list and fill in the figures that have been collected.

To add information for another pond, simply click on it in the list.



Note:  If , as in the screen above, you have specified two readings for a certain property, this process must be carried out twice, at two different times. Under the first time specified, enter what information you can and leave the rest blank.  Once you have more information, you carry out the process again, using the second time.  The information you entered earlier will not appear at this stage, but is still held in the system.   To view all the readings for one day, simply change the mode in the Command Centre to “Update data” and click on “Execute”.



Water Input



Here you enter the amounts for water related products that are to be added to your ponds.



From the Command Centre, choose the appropriate farm, crop, unit and pond.

After making sure you are in “Insert data” mode, choose the date and time for the addition.

Click on “Execute”.

On the list on the left hand side of the screen, click on the relevant pond.

You can now go down your list and fill in the figures that have been collected for each product added.

To add information for another pond, simply click on it in the list.



Note: The “In Stock” column shows the number of each product held in the inventory and is updated after each entry, when you press “Post”.  The number in stock of  products shown in red has fallen below the reorder level specified earlier.



Pond harvest



Here you enter the relevant information about your harvest, such as quantity, customer and price.



From the Command Centre, choose the appropriate farm, crop and unit.

After making sure you are in “Insert data” mode, choose the date and time for the harvest.

Click on “Execute”.

You can now enter the information about your harvest per pond including Harvest Cost, remembering to click on “Post” after each entry.

Click on the “Save” button when you are finished.



Note: The revenue from the harvest is automatically calculated from the Price per kg, the yield and the Harvest Cost.  It is given once you press “Post”.

Pond calculations



From the data recorded in the system, AquaSoft calculates production data related to each pond. From these calculations pond performance and financial statistics can be determined. All calculations are based on data collected at time of sampling, which varies from farmer to farmer. Production data can also be viewed as a series of graphs, which provides a useful overall representation of pond performance. 



Note: data recording must be accurate for production calculations to be reliable.



Production calculations



�



This screen gives you production figures based on your sample information.



From the Command Centre, choose the farm, unit and crop you are interested in.

Note that you can only use the “View mode” in the Command Centre

The following screen appears, showing statistics relating to the pond highlighted on the left hand side.

To see the figures for another pond, simply click on it in the list on the left hand side of the screen.

To see this data in graph form, click on the “View Graph” button.  The following screen will appear:
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The graphs that appear relate to the pond highlighted on the left hand side.  On the right hand side there are two identical lists, one for each graph.  This is so you can see two graphs at once.  All graphs are plotted against days from the Start Date of the crop concerned.

You can change the way the graphs appear by clicking on the graph with the right mouse button.

From the menu that appears, choose “Plotting method”, and then one of the choices given.

From the same menu, you can print the graph.  Choose “Export dialog” and then choose “Printer” as the “Export Destination”.  Now click on “Print”.



Feed calculations



This screen supplies more calculations based on the sample information.  The calculations are all linked with feeding habits, such as feeding rates and predicted growths.  The screen also recommends the amounts of feed to be given for the following ten days.  Graphs are accessed and treated in the same way as for “Production Calculations”.



Note: the projected data for feed must be taken only as a management guideline, as any form of forecasting shrimp performance is unreliable.   



Recalculate Statistics



To speed up the production calculation process it is advised after recording sampling data, you

 recalculate production and feed statistics. When recalculating statistics the next time, AquaSoft only needs to go back to the last time data was recalculated. This facility improves efficiency in the system.



  To do this, simply choose "Recalculate statistics" from the main screen, and on the below screen, press the "Recalc" Button.  The statistics given in the system will now take into account the new information.
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Inventory



Inventory control and analysis is designed to help your staff maintain all inventory records with greater efficiency and accuracy. AquaSoft’s Inventory control can be used alone, or as part of an integrated system with other accounting packages.



Note: Please contact SNR if you would like information on integrating accounting packages with AquaSoft.



Inventory control features:-



The Inventory control maintains detailed inventory records and produces reports that help you manage your stock effectively. 



Stock products



The method used here is exactly the same as for adding ponds to a farm.  Again, you can either click and drag, or use the “Insert” button, to add products from the list on the left hand side.  You then supply information on the purchase, and click on the “Post” button.



For adding purchases, the list is split up into the categories you specified in the “Product Categories” section of “Setup”.  To move between these lists, choose a category from the drop down list which appears when you click on the � button.



Once the record of a purchase has been entered, the only information which can be changed is the unit price paid.  To do this, select the entry to be changed by clicking on it, then type the new price into the box beside the � button.  Press this button and the entry will be updated.



If an entry has been wrongly entered, you must reverse it using “Dump Stock”, as discussed next.



On screen, there is also a “View Inventory” button.  This takes you to the “Inventory View” section, as discussed later.

 

Dump stock



It may be necessary during the running of a farm to dump some or all of a product.  The method used here is exactly the same as for adding ponds to a farm.  Again, you can use either the click and drag method, or use the “Insert” button, to choose products from the list on the left hand side.  You then supply information on how much to dump and the reason why, and click on the “Post” button.  You will see in the top left hand corner of the screen, the amount of stock for the product you have highlighted.  You cannot dump more than this amount.  The number in stock is automatically updated throughout the system once you press the “Post” button.



Note:  If an entry in the inventory needs to be removed, you can remove it here.  To remove an entry, simply duplicate the entry to “Dump” the number wrongly added.  For example, if you accidentally entered a purchase of 10 kg of Pellet Feed No. 2 when it should have been Pellet Feed No. 1, “Dump” 10 kg of Pellet Feed No. 2, giving a reason such as “Purchase reversal”, then enter the correct information in “Stock Products”.





Inventory View



This screen shows information on everything that is in stock.  From the Command Centre screen, you choose the farm concerned.  With this option you can only View the information - you cannot edit.
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There are two views available - either “Show all” or “Show re-order”.  As the names suggest, “Show all” shows all entries and “Show re-order” shows only stock items that have fallen below re-order levels.





Reports



The AquaSoft system has been designed so that you can use all information relating to your farm.  It allows you to store information which you gather and ,using this information, provides you with relevant Production and Financial information.  However, if your system is to be fully effective, you must be able to present this information in an attractive and informative manner on paper.



When you start AquaSoft from Windows, you will have noticed another Icon labeled AquaRep.  This is a reporting package designed to run alongside the AquaSoft system.  Using the information stored in AquaSoft, this package will produce a wide variety of reports which you can either print or export to a wide variety of other packages.



The AquaRep System



When you start AquaRep, you will be presented with a similar logon screen to that for AquaSoft.  Your Password for the two systems is the same.



After entering the AquaRep system, you will be presented with the following screen, which lets you specify the report you wish to use:
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The screen is split up into three sections:



In the left section, you choose the specific report you are interested in. 

In the middle section of the screen, you specify which farm, crop, unit and pond you are interested in.

In the right section of the screen, you specify the appropriate time and stage you are interested in.  



You choose options here in the same way as on the “Command Centre” screen in AquaSoft.  As with the “Command Centre” screen, the options available here depend on which aspect of the package you are interested in.



Choosing a Report



In the AquaRep system there are over forty reports which can be compiled for your information. The reports themselves are grouped in two ways:



They are grouped by what they concern , i.e. whether they concern a specific pond, a whole crop, or an entire farm.   

They are grouped by the type of information they concern, i.e. whether your report is based on  “Production” information, “Financial” information, or information you wish to view as a “Graph”.



The layout for choosing reports is very similar to that used in Window’s File Manager.  Reports are grouped into folders holding those using similar information.  The first, most general, level is shown on screen as:
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To open one of these folders, simply double click on the (folder icon) icon.  This will show the next level of detail:
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From this level, you choose whether a Report is a “Production” or a “Financial” report, or a “Graph” by double clicking on the appropriate folder.



Now that you have gotten to the lowest level of detail, the reports themselves which are shown with a (report icon) icon beside their names, you choose a report by clicking on it.  The report name will now be highlighted and a description of the report is shown in the box in the top left of the screen.



You must now specify which part of our farm you are interested in.  This is done in the middle section of the screen by clicking on the appropriate Farm, Unit, Crop and Pond.  Obviously, not all this information applies to all reports, so for each report you need only make selections in boxes with a white background in this area.  Those boxes with a gray background, such as Pond name when dealing with general Farm Reports, can be ignored.



You have now chosen which report you want, for what part of your farm.  You now specify the period of time you are interested in, in the right hand section of the screen.  Not all reports rely on time, so if the information in this section is grayed, this section can be ignored.



If your report does depend on time, it can do so in two different ways:



A report can depend on exact times.  For this type of report, you will be able to type the relevant dates and times into “Start Interval” and “End Interval”.  Each report will give suggestion dates and times to give the widest range of information.  If you want to use the same date and time for several reports, click in the “Fixed” Box.  This will override the system’s suggestion times to keep your interval constant.

A Report can depend on the stage in the crop cycle.  For this type of report you can choose whether the information you want relates to “Preparation” or “Production” in your crop cycle by clicking on the relevant one.  A ( indicates the current choice.

Some reports can work in either way.  If this is so, you can either type in specific dates, or choose a stage.  Notice that if you choose a stage, what happens is that the correct interval is filled in automatically.  However, the report is always based on the time interval given, so any Times you enter override the stage Information.



Once you have made your choices, simply press the � button and a preview of the appropriate report will appear.  Below is an example of the “Chart of Accounts” report:
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Your report is now completed, using the relevant data from your system and you can now perform a variety of functions:



To zoom in on the report, there are three button, �, which switch you between viewing the full report, viewing the report full size and scaling the report to appear one screen wide.

To print the report, simply press the � button.  The print box relevant to your printer will appear, allowing you to specify options.

To export the report to another package, such as Excel, simply choose the �, choose the appropriate file type and give the file a name.  The report can now be opened and edited in the appropriate package.



Note: When you open the first report of a session, you will be asked for your password.  This is the same password as for AquaRep and allows the system to connect to the information stored in AquaSoft.



To return to the main screen, simply minimize the  report screen.  You can now either choose another report, or leave the package.



Graphs



Some of the information stored in the AquaSoft system is best displayed graphically.  Graphs are accessed in the same way as reports, giving a screen similar to this:
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For graphs showing more than one statistic, the statistics displayed can be chosen from the drop down lists at the top of the screen.  The axes will be automatically updated.  Occasionally, as in the graph above, it is relevant ot use the same scale for both statistics.  To do this, click on “syncronize limits” so that an “X” appears in the box.

For financial graphs, different statistics are chosen using the tabs at the bottom of the screen.

You can change the way the graphs appear by clicking on the graph with the right mouse button.

From the menu that appears, choose “Plotting method”, and then one of the choices given.

From the same menu, you can print the graph.  Choose “Export dialog” and then choose “Printer” as the “Export Destination”.  Now click on “Print”.

To return to the main screen, press the “Close” button.
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